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SiteCatalyst ClickMap

This document describes the SiteCatalyst ClickMap tool. This tool is designed to let you see your Web site analytics directly on your Web 
site. The document gives an overview of the tool, installation procedures, and directions for using the ClickMap tool.

ClickMap Overview
ClickMap is an Internet Explorer plug-in, and a module of SiteCatalyst, that allows Omniture clients to visually measure traffic, conversion 
and success metrics within the pages of a Web site. These metrics are overlaid on top of the page's links and answer critical questions, 
including the following:

•   What is the value of an individual page on your site?
•   What is the value of an individual element on a web page?
•   What is the most valuable “digital real estate” on your page?

SiteCatalyst ClickMap lets you answer these questions and more at a glance. A visual display highlights the most relevant elements on 
your Web page and calculates the overall value of that page to your site’s success, based on the following items.

•   Revenue, Orders, Checkouts, and more
•   Cart Additions
•   Conversion Funnels and Ratios
•   Any other success metric you define

ClickMap is just one of the many features SiteCatalyst uses to provide real-time, bottom-line information that quantifies the effectiveness 
of Web site and marketing initiatives. Going beyond simple data points about historical site activity, SiteCatalyst provides actionable 
information that allows immediate action on factors that most affect success. Basic ClickMap metrics are included by default with 
SiteCatalyst services, and conversion and custom metrics may be added by contacting your Omniture Account Executive. Data collection 
to support ClickMap is enabled automatically during SiteCatalyst implementation. ClickMap does not require additional implementation 
effort, nor does it require adding code to the HTML pages. ClickMap functions automatically after the JavaScript (.js) file is placed on the 
page.

Installing the ClickMap Plug-in
The ClickMap plug-in requires one of the following operating systems:

•   Microsoft Windows 98 or later
•   MAC OS X 10.3.x or later

The following browsers are supported:

•   Microsoft Internet Explorer version 5.5 or later
•   Mozilla Firefox 1.5 or later

To install the plug-in, you must be logged into your operating system with administrator rights to install applications. You download the 
plug-in from within the Omniture Suite. The following are also necessary:

•   You must have the be able to download signed ActiveX controls 
•   Script ActiveX controls must be marked safe for scripting. 
•   JavaScript must be enabled

To download ClickMap

1.  Log in to the Omniture Suite.

2.  In the menu on the right, click Analysis Tools > ClickMap.

3.  Click Install the Click Map Plug-in.

4.  Use your Operating system tools to install ClickMap.
SITECATALYST CLICKMAP USERS GUIDE 1



 SiteCatalyst ClickMap
NOTE: You may need to install active x controls, or click specific tools in your Web browser to enable the installation to proceed.

5.  Click Close Window.

6.  Restart your computer.

Logging in to ClickMap 
After you install the ClickMap Plug-in, the ClickMap icon displays in the Standard Buttons Toolbar in your Web browser. The following 
procedure explains the process to login to and use ClickMap.

To log in to ClickMap

1.  Open your browser.

2.  Navigate to the desired Web page.

3.  Click the ClickMap Icon.

Figure 1.1: ClickMap Icon Highlighted

4.  Log in to ClickMap with your SiteCatalyst username and password.

Figure 1.2: ClickMap Login

5.  Click Login to SiteCatalyst.
The successful login will displays a color overlay on the selected web page. The overlay displays different color shades to show link 
usage - the darker the color, the more clicks.
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ClickMap Data Overlay Display
The ClickMap data overlay is a visual representation of your Web site Statistics. When you see the overlay, clickable areas of your Web 
page have box overlays that appear darker on the screen depending on the number of clicks the users clicked on the link. When you hold 
your mouse over any overlay area, a popup appears that displays the metric you have selected, nd the tank of that link compared to all 
links on your Web pages. Figure 1.3 displays an example of an overlay screen.

Figure 1.3: Web Page with ClickMap

In Figure 1.3 the cursor is currently hovering over the Omniture link, and the popup shows the information. Changing the Reporting 
Metric in the menu on the left alters the data shown in the popup. If you want the popup flag to remain after you move your mouse, you 
can click the thumbtack icon to keep the flag on place.

Additionally, the overlay over the Client Login link is much darker than the other overlays. This is because this link has been clicked more 
times that the others.

NOTE: The plug-in installation will fail if “Download signed ActiveX controls” is disabled within the Security Settings Tab in Internet 
Explorer. The plug-in requires JavaScript to be enabled for ClickMap to function properly. The page displayed must also contain the 
matching Report Suite ID (Site/Segment) that is selected in the pop-up menu in the ClickMap plug-in window. 
Also, ClickMap Increases the size of your Web page to accommodate for pop-ups. If you hover over an overlay that displays to the right 
of your screen, you can scroll over to see the popup.

If frames exist in the Web page being tracked and reported with ClickMap, the plug-in searches each frame in the frames collection, 
starting from frame 0 until it finds the first frame with the SiteCatalyst tracking code and a matching Report Suite ID. This is the only 
frame within the frame set that displays the ClickMap data overlay (generally, only one frame has actual content that is tracked in 
SiteCatalyst). Multiple frames are not currently reported in ClickMap.
SITECATALYST CLICKMAP USERS GUIDE 3



 SiteCatalyst ClickMap
ClickMap Controls
To the left of your screen you see the ClickMap control set, shown in Figure 1.4. Each of these is described in this section.

Figure 1.4: ClickMap Controls

SITE/SEGMENT MENU

The Site/Segment menu links up the Web page with the correct data set. Select the setting the corresponds to the Web page you are 
analyzing. The page name that corresponds to the selected report segment displays beneath the menu.
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REPORTING DATE

The link to the left of the reporting date opens a calendar tool that you can use to select the date range for ClickMap. If you select large 
date ranges, ClickMap requires more time to build the reports.

To use the calendar tool

1.  Click the link to open to tool.

The calendar section lets you choose the time periods for which you view report statistics. The calendar tab gives you an opportunity to 
select standard periods of time, such as a day, week, month or year. The Range tab lets you select and view data over any other custom 
time period.

Figure 1.5: Calendar

To change the report date from the Calendar tab

1.  To change the year, click one of the arrows next to the year at the top of the calendar. The year between the arrows changes 
accordingly. When you have found the desired year, click the year text. The year text will be unavailable (gray) if statistics are not 
available for that year.

2.  To change the month, click one of the arrows next to the month abbreviation. The month between the arrows changes accordingly. 
When you have found the month you would like to view, click the month text. The month text will be unavailable (gray) if statistics 
are not available for that month.

3.  To view by quarter, click the Months sub-tab and then click the left-arrow next to the desired three-month period. 

4.  To change the day, click the desired day in the main body of the calendar.

5.  To view by week, click the Days sub-tab and then click the left-arrow next to the desired week.

NOTE: The Calendar always highlights the time period being viewed in yellow. Time periods that are available for viewing appear in 
bold font. 

To change the report date from the Range tab

1.   Click Range.

Figure 1.6: Calendar Range

2.  To view a report for any of the preset time periods do one of the following:
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a. Choose one of the options from the Select Preset drop-down box. The appropriate dates appear in the From and the To text 
boxes.

b. Choose the level of granularity from the Show By drop-down box (“Trended” view only).

c. Click Run Report.

3.  To view a report for the time period you set:

a. Type a starting date in the From text box.

b. Type an ending date in the To text box.

c. You can also click Calendar icon next to either of these fields, then navigate to and choose the desired date from the pop-up 
calendar window.

d. Choose the level of granularity from the Show By drop-down box.

e. Click Run Report.

REPORTING METRIC

You can change the information shown in the report by changing the value in the reporting metric menu. These values are determined 
based on the data collected on your Web site. The default is number of clicks. When you change the value, ClickMap must rebuild the 
report. If you have selected a large date range, this can take several minutes.

CHANGE OVERLAY COLOR

You can change the color of the overlays to stand our better against the color of your Web pages. The available colors are red, green, 
blue, and yellow. AA menu shows the available colors, as shown in Figure 1.7.

Figure 1.7: Change Overlay Color

OVERLAY TRANSPARENCY

You can alter the transparency of the overlays to highlight them according to your preference. Click and slide the slide bar on the control 
to alter the setting. At fully opaque, you cannot see the Web page object under the overlay. At fully transparent, you cannot see the 
overlay, but you still see the popup if you place your mouse over the link. The tool to set this is directly below the color change tool in 
Figure 1.7.

AUTO FLAG TOP VALUES

When you click this check box, Click Map automatically displays, by default, popup data for the top five overlays. You can change this 
value by clicking the links to the left of the box. You can change the number and configure ClickMap to show the bottom values if you 
choose to do so. Figure 1.8 shows an example of the selection menu.
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Figure 1.8: Change Value Settings

DISPLAY PAGE

When you clear this check box, the Web page is not visible, but you can see the overlays. This can be helpful when you want to clearly see 
all the overlays.

DISPLAY OVERLAYS

When you clear this box, the overlays do not display on your Web page, as though you were not running ClickMap. If you remove the 
overlays, and then want to view them again, you may need to click the link to the left of the box to refresh your report.

CHANGING SEARCH INTENSITY

On occasion if you have altered your Web pages, you may see a notice that some links were not found, as shown in Figure 1.9.

Figure 1.9: Missing Links Message

By default, ClickMap attempts to locate an object (link) on a page by searching within 16 objects of its previous or recorded location (a 
setting of 8 tells ClickMap to search eight objects above and eight objects below). By increasing the Search Intensity setting, this depth of 
searching may be increased. Search intensity may be increased by clicking the Tell Me More Link in ClickMap, and the pop-up window 
shown in fig displays.
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Figure 1.10: Search Intensity Setting

NOTE: According to the W3C's “document object model”, all tags on a page - including HTML comments, <br>, <b>, and <p> tags 
- are counted as objects. Characters and text are not counted as objects. A single paragraph on a page could be increased from 10 to 
10,000 characters and ClickMap would still accurately report all links. Generally speaking, this search feature allows ClickMap to easily 
handle most minor page changes. However, adding nine links to a page above a particular link would move it enough to affect its 
ClickMap reporting under the default search intensity setting. Of course, if the page is altered that much, it is questionable to what extent 
the ClickMap data collected prior to the change applies to the page anyway. Using a unique identifier in the “s_objectID” variable will 
overcome the need for searching because each link can be uniquely identified. For more information, see “Uniquely Identifying Links” on 
page 12.

Dynamic Menus
Sites that dynamically create menus when the menu is accessed for the first time (after page load) cannot be rendered by ClickMap. The 
ClickMap overlays are drawn before the user is able to click or expand any of the menus, so the objects do not yet exist. The clicks on 
these types of menus will be accounted for in the Search Intensity Settings Window. For more information on search intensity, “Changing 
Search Intensity” on page 7. ClickMap works better for dynamic menus that are created during page load, and are later toggled to 
display these hidden menu objects.
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Individual menu items in pop-up menus (an HTML “select“ menu), when used for navigation, are not tracked by ClickMap. Generally, 
the “Go“ button used in conjunction with such menus are tracked instead since the button is the last item clicked.

ClickMap Data Collection
Data collection for ClickMap requires SiteCatalyst code version G.0 (G zero) or greater, and must be enabled by your Implementation 
Consultant for ClickMap. Within the SiteCatalyst code (.JS file), the “s_trackInlineStats“ variable (replace s_ with s. for H code) must be 
set to “true“ within the JavaScript tracking code. Once enabled, any object on a web page that includes this code will be tracked by the 
.JS code if it either has an HREF attribute or an ONCLICK event, or is a form input type of SUBMIT, BUTTON, or IMAGE. Macromedia 
Flash objects are not currently tracked automatically. Refer to the Implementing Flash Tracking white paper for more information on 
ClickMap and Flash.

NOTE: Clients using a version of SiteCatalyst code earlier than version G.7/G.8 should update to the latest version.

BROWSER REQUIREMENTS

ClickMap collects data in all Internet browsers. Additionally, browsers must support JavaScript and session cookies in order for the click to 
be measured by SiteCatalyst.

UNREPORTED EVENTS/DATA

The following events are not tracked by ClickMap because Internet browsers do not currently provide a mechanism to capture these 
events:

•   Back or Forward browser buttons/menus
•   Use of the History buttons/menus
•   Clicks within Macromedia Flash objects, menus, and animations (Flash may be tracked by specific SiteCatalyst code)
•   Navigation using the Favorites buttons/menus SiteCatalyst tracking code is able to support data collection for all browsers. However, 

ClickMap currently only attempts to display data tracked from Internet Explorer, Netscape/Mozilla, Firefox, Opera, and Safari on 
Microsoft Windows.

NOTE: Objects specially tagged using the “s_objectID“ will be reported even for non-IE browsers. For more information about 
s_objectID, see “Uniquely Identifying Links” on page 12.

IDENTIFYING LINKS

Links are uniquely identified by the following pieces of information. The first four methods of identification are automatically obtained by 
the SiteCatalyst JavaScript code.

•   Position relative to other objects in the HTML page
•   “Action“ - See “Internal Links” on page 10.
•   Page Name (or URL, if s_pageName is not populated - replace s_ with s. for H code)
•   Tag or object type (IMG, INPUT, BUTTON, etc.)
•   Value of “s_objectID“ attribute, which requires adding code to each link. When used, #1, 2, and 4 are ignored.

The 5th method of identification does require modifying the link, but it is the most reliable. It can be used on a limited number of 
“critical“ links on a page in order to ensure the highest accuracy possible.

NOTE: A page name or URL (when page names are not used) can result in multiple pages reporting the link click-throughs on a more 
granular basis than is otherwise desired.

EXTERNAL VS. INTERNAL LINKS

Data collection for links is different, depending upon whether the link leads to an external page, or to another internal page on the site. 
Because of this, it is important to understand what is considered an “external“ link, the effect of implementing only a portion of a web 
SITECATALYST CLICKMAP USERS GUIDE 9
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site, and how Page Names and Page URLs (and query strings) affect ClickMap. The importance of “internal“ and “external“ links is as 
follows:

•   Internal links store information in a session cookie on the page that the click occurs, and the information is sent on the next page. 
(For this reason, it is important that the pages that these links point to all have SiteCatalyst code implemented.) Note that if the user 
does not later navigate to another internal, implemented page, the data may not be sent.

•   External links send the ClickMap data immediately. This results in an additional server call since it occurs after the “pageview“ server 
call for the current page, and since there is no next page to “piggyback.“

Internal Links

Links are considered internal if (1) the HREF attribute is identified as “internal“, or if (2) the object to be tracked is a FORM element. For 
objects that have HREF attributes (a URL specified for the link), the “internal domain filter“ variable is used to determine whether the link 
is internal. Within the JavaScript file, SiteCatalyst defines this domain filter variable, named “s_linkInternalFilter“ (replace s_ with s. for H 
code). This filter specifies if ClickMap considers the link as an internal page - if the filter is included as a portion of the HREF (the 
destination URL), the link is considered internal.

The logic for defining internal links is as follows:

if (object clicked has an HREF attribute) {
if (HREF scheme is “javascript:“ AND object has an ONCLICK event) {

Use ONCLICK to determine action
} else {
Use HREF to determine action (s_linkInternalFilter - replace s_ with s. for H code)
}

} else if (object is a FORM INPUT element) {
if (type is SUBMIT or BUTTON) {
Use VALUE to determine action
Track as INTERNAL link

}
if (type if IMAGE) {

Use SRC to determine action
Track as INTERNAL link

}
} else {

Use ONCLICK to determine action
Track as INTERNAL link

}

The “action“ is either a part of the HREF, SRC, or OnClick. It is a portion of the data that is stored in the session cookie (or sent 
immediately for external links) that is associated with the link. Additionally, because all “Form“ objects are assumed to be internal links, 
in many cases these links are not tracked by ClickMap if the Form is submitted to a site (or page) that is not implemented with 
SiteCatalyst code. For instance, a product page on http://www.mystore.com/ may submit a form to http://store.mystore.com/. The pages 
at store.mystore.com would need to be implemented in order to correctly track the clicks to the form elements.

Form elements other than Button, Submit, or Image may also be tracked. This is because a user can click on a text field or checkbox, 
proceed through the form by using the keyboard tab button, and then press Enter on the keyboard to submit the form. The last item 
clicked will be tracked as a result. If the “s_linkInternalFilter“ variable (replace s_ with s. for H code) is left blank or not defined, all links 
will be defined as internal.

External Links

Any link not considered internal will be treated by ClickMap as external, and will be tracked as long as “s_trackExternalLinks“ (replace s_ 
with s. for H code) is set to “true“ (otherwise, links to external sites/pages will not be reported in ClickMap).

NOTE: The s_trackExternalLinks (replace s_ with s. for H code) variable also affects the “Exit Links“ report within SiteCatalyst. A link can 
be forced to track as external by implementing the “s_linkType“ variable (replace s_ with s. for H code) (set “s_linkType='e';“ in order to 
designate the link as external).

In many cases, internal redirects may be used in order to redirect the user to a page offsite. In these cases, it is necessary to specify the 
redirect link as external (using the “s_linkType“ variable (replace s_ with s. for H code) within the “onclick“ event code) so that the data 
is captured. The redirect page is generally a server-based page and is not implemented with SiteCatalyst code. Here is an example of a 
redirect link within the HTML page:
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<a href=“redirect.cgi?dest=http://somesite.com/apage.html“>External Link</a>

To implement as an exit link for both ClickMap and for the “Exit Link“ report, add an “onclick“ JavaScript as follows:

<a href=“redirect.cgi?dest=http://somesite.com/apage.html“
onClick='s_linkType=“e“;s_linkName=“LINK_NAME“;s_lnk=s_co(this);
s_gs(“REPORTSUITEID“)'>External Link</a>

PAGE NAMES AND URLS

Pages are identified by Page Name (specified in the s_pageName variable - replace s_ with s. for H code), or by URL if the page name 
variable is not populated. The best practice for implementation of SiteCatalyst when ClickMap is to be used is to populate the 
“s_pageName“ variable (replace s_ with s. for H code) uniquely for each page of the site (a “page“ being defined as “when the links on 
the page are unique“). When the page name is not defined, the URL is used to define the page. By default, only the URI stem is used to 
uniquely identify each page and the query string is ignored. Shown below is an example of how the Page Name might be related to a 
URL consisting of both a URI stem and query string.

NOTE: To create multiple pages, “default.asp“ is used.

In this example, the URI stem is the same in both cases, although the overall URL indicates 2 completely unique pages. If the query 
string is not included on pages where Page Name is not populated, the links will appear that they are all on the same page. When 
reporting, some links will not be found. Some links may become confused with other links as a result. 

The entire URL may be enabled for ClickMap in order to create sufficient link “uniqueness“ to identify the page. This is accomplished by 
configuring the URL filter within SiteCatalyst, which must be completed by your Implementation Consultant. However, specific filters must 
be applied if the links contain user-specific data within the HREF. For instance, this might include session IDs, zip codes, and other data 
that is used to build the URL based on the data the user has entered. By default, the query string is ignored. The 
“s_linkLeaveQueryString“ variable (replace s_ with s. for H code) in the JavaScript file is used only for link tracking.

NOTE: By enabling the query string for data collection, the page names within SiteCatalyst will also be affected. Before enabling this 
feature, ensure that the resulting SiteCatalyst reports will be acceptable (two URLs with different query strings will be reported as 
separate “pages“). In some cases, this will “break up“ a page into too many different versions and report data that is too granular, which 
is especially true if the URLs contain any user-related data such as session IDs, zip codes, or other form entry data. Your Omniture 
Implementation Consultant can help you design a URL filter that will eliminate user-related information from all URLs.

Pages that are tracked by URL (pageName is not populated - replace s_ with s. for H code), may also encounter issues if the page may 
be loaded under various domains or second-level domains (such as “http://mysite.com“, “http://www.mysite.com“, and “http://
store.mysite.com/“). Since the base URLs are different, they are tracked as separate pages (and thus, as separate groups of links), both 
in SiteCatalyst and in ClickMap. The recommendation isto use page names to identify pages in order to avoid situations like this that will 
“split“ the data on a single page into the various cases (http://mysite.com/, http://www.mysite.com/, etc.).

The current URL also affects relative links in the page, as well (“/directory/page.html“), and will “split“ the links between “Page X“ when 
it is loaded under “http://mysite.com“ and when it is loaded under http://www.mysite.com/. Absolute links may be used in order to 
overcome this consequence (http://www.mysite.com/directory/page.html), or a server-side redirect may be used to ensure that a page is 
always loaded as http://www.mysite.com/ (redirects all traffic from http://mysite.com/ to http://www.mysite.com/).

URL Filters
Your Implementation Consultant will work with you to install URL filters when the query string is required for an appropriate level of 
uniqueness to identify pages. These filters must be applied to any portion of a URL (either the page's URL, or the links within the page) 
that may contain user-specific data (session IDs, zip code, login IDs, or other user-specific information passed in URLs or HTML forms 
when using the GET method).
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NOTE: All user-specific query string parameters must be identified in order to create URL filters. A day's worth of server logs for all 
domains (sites) is often helpful to determine all of the unique query string parameters used. Optionally, if the SiteCatalyst Advanced Data 
Warehouse option is enabled, the data may be obtained by reviewing the previous day's log. This is preferable because it identifies all 
pages that are implemented with SiteCatalyst code.

IDENTIFYING INDIVIDUAL LINKS

Links are identified by a combination of data elements, including the page on which the link is located, the position on the page relative 
to other objects, the destination HREF, and type of link. However, on highly dynamic sites, ClickMap may not be able to correctly identify 
individual links if a large number of changes are made to a page.

Uniquely Identifying Links

SiteCatalyst provides a method to uniquely identify links regardless of the destination HREF of the link, or the link's position on the page. 
This strategy also supports browsers other than Internet Explorer. A specific variable is set in the “onclick“ event in order to uniquely 
identify a link. This variable, “s_objectID“, is tracked by ClickMap, allowing the link to be found regardless of how far the link moves on 
the page, or where the HREF (URL) points to, as shown below.

<a href=“http://www.asite.com/somepage.htm“ onclick=“s_objectID='SS1234';“>Some Site Link</a>

This code snippet allows the link to be reliably identified, and ensure the accuracy of reporting.

NOTE: The s_objectID is case-sensitive, so ..s_objectID=..A12345.. and ..s_objectID=..a12345.. will be considered to be different 
values:
•   Whitespace can be between the '=' in an s_objectID assignment (e.g. , s_objectID<WS>=<WS>'value';)
•   Quotes (single or double) MUST be used in the assignment for the actual ID (for s_objectID assignments).
•   s_objectID assignments may be made anywhere within the onclick event, as long as they conform to the above specifications.
•   Spaces may be used within any action (s_objectID or not), and they will be preserved correctly (i.e., s_objectID='Back Button';)

THE DYNAMIC OBJECT ID ASSIGNING FUNCTION

The s_objectID must be assigned directly or the ClickMap overlay will not function correctly. The Dynamic Object Assigning function 
assigns the s_objectID directly. This function is a custom JavaScript plug-in that your Implementation Consultant will add to your .js file. 
Use it in the following situations:

•   When URLs are consistently over 100 characters in length, especially if the portion before the query string is over 100 characters. 
The Clean Page URL manager will strip the query string in most cases, which is why the piece before the query string is what 
matters.

•   When the URL contains a session ID or timestamp that cannot be cleaned up by the Clean Page URL manager. This happens when 
there is no identifier for the session ID, for example, if the number in http://mysite.com/12345/home.html is a timestamp, then we 
have to use this plug-in.

CLICKMAP FOR OLDER PAGE VERSIONS

You can review the ClickMap reports on older versions of pages, or pages that have been discontinued altogether, if you have a copy of 
that page available to load in a browser. To provide copies of the page for this purpose, Omniture recommends that you periodically save 
key pages to a local directory or server. Use the “File > Save As...“ feature within Internet Explorer, and save either as “Web page, 
complete (.htm or .html)“ or “Web archive, single file (.mht).“

Omniture also recommends you include in the file name some designation as to the dates the page was active for your future reference. 
To view the metrics for the archived page, load it using the “File > Open“ feature, then use the “Browse...“ button to select the file from 
the directory or server from which it was saved. The HTML code of the saved page will contain the original URL from which it was 
loaded, enabling ClickMap to report metrics for the saved page.

NOTE: Do not save the view page source.

For pages that are highly dynamic, or contain sections that change from day to day, archiving of pages may be an effective method of 
using ClickMap to report these pages that change frequently.

The current URL filters in place at the time that the pages are viewed within ClickMap will be used. If the URL filters have changed since 
the file was saved, the filters will no longer be applicable to the saved page.
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OTHER LIMITATIONS

If you have enabled any type of sampling for SiteCatalyst metrics, special consideration will be required in order to use the ClickMap 
plug-in. The ClickMap plug-in user must also be a part of the sample group for ClickMap reporting to function correctly. ClickMap uses 
the SiteCatalyst image request in order to identify the Report Suite ID and page name (or URL). If the image request has not been made 
(because the ClickMap user isn't in the sample group), ClickMap does not know which page or Report Suite is being viewed. Please 
contact Omniture Live Support for additional information.

PAGE-BASED PROCESSING

ClickMap will load the overlays after the <body> tag's “onload“ event has been triggered, and all “onload“ events have fired and the 
page has completely rendered. However, in some cases, other operations that complete after the “onload“ event may need to use 
ClickMap's semaphore feature.

If the page includes JavaScript that modifies links or other content, it can set the “s_semaphore“ <body> tag attribute to a non-zero 
value initially, and then set “s_semaphore“ equal to 0 (zero) once it is complete (in the “onload“ event function, for instance). ClickMap 
will wait to display the overlay until “s_semaphore“ is 0. The <body> tag may initially be set as shown below (replace s_ with s. for H 
code)

<body s_semaphore=1 (replace s_ with s. for H code) marginwidth=1 marginheight=1 ... >

After the processing completes, set the “s_semaphore“ variable to 0 (zero) in order to trigger ClickMap to begin displaying the ClickMap 
report overlays, as shown in the JavaScript statement below.

...
document.body.s_semaphore (replace s_ with s. for H code)=0;
...

PERCENTAGES AND MEASUREMENTS

There are a number of factors that may result in percentages of a metric not adding up to 100%, regardless of whether the metric viewed 
is Clicks, Orders, Revenue, or custom events. Here are some scenarios and instances that can result in less than 100%, or in a total that 
doesn't match related metrics (such as the total number of people that visit the page).

•   In some cases, browsers other than Internet Explorer, Firefox, Netscape, Opera, and Safari are not reported. Although this is a small 
percentage, it accounts for some clicks and other metrics. Using the “s_objectID“ within links to uniquely identify them addresses 
the browser reporting issue.

•   Use of the “Back“ and “Forward“ Buttons, “Favorites,“ and “History“ creates differences between the total number of page views 
and the total number of clicks from that page.

•   User-specific links may create differences between total page views and total clicks from that page. An example is when a user 
name or identifier is in the query string, and is not correctly filtered (make certain all URL filters are set up correctly and take into 
account all query string parameters).

•   Forms that allow the <Enter> key to be used to “submit“ the form will not be measured by ClickMap. In some cases, form elements 
other than the submit button may be credited with the click instead.

•   Customers may bookmark the shopping cart or checkout page and return in a different session. The total session revenue or orders 
would not therefore be equal to total links.

•   Additional clicks may also be listed in the “Missing Links“ screen. ClickMap does not measure visitors who leave the page by closing 
the browser, and accounts for some differences between total page views and the total number of clicks from that page.

VISTA RULES

The VISTA architecture allows both URLs and Page Names to be changed after the data has been received by SiteCatalyst. Because this 
data will not match the page names and URLs being sent by the ClickMap data collection, special consideration must be made. One 
potential solution is to use a duplicated report suite to send all unmodified data for ClickMap reporting. The entire site's traffic need not 
be sent to the report suite if only a few specific pages need to be reported via ClickMap.

Technical Sequence and Overview
ClickMap collects information from the web site's pages for each visitor and sends it to Omniture's data collection servers. The ClickMap 
plug-in relates the collected data to the page by matching the page name or URL to the stored data, and overlaying that data graphically 
over the web page in real time.
SITECATALYST CLICKMAP USERS GUIDE 13



 SiteCatalyst ClickMap
DATA COLLECTION

The steps to collect data for ClickMap are shown below.

•   Data is collected by SiteCatalyst JavaScript by “hooking into“ the “onclick“ event for all clickable objects on the page (links, form 
input objects, etc.). The body's “onclick“ event is used for this functionality, and will not interfere with individual object “onclick“ 
events, nor other “onclick“ event code in the <body> tag.

•   Data is collected for all browsers (does not require a specific browser).
•   URLs are filtered by the SiteCatalyst data collection servers if a URL filter has been set up, and generally removes session-specific or 

user-specific data from page and link URLs.
•   VISTA rules may modify page names or URLs.
•   The ClickMap data is loaded into the database, and indexed in real time.

DATA REPORTING

The steps to report data in ClickMap are shown below.

•   The ClickMap plug-in is loaded into the browser.
•   When a web site page is loaded, the plug-in begins to execute. If s_semaphore (replace s_ with s. for H code) is declared as a 

<body> tag attribute, and is set to a non-zero value, the plug-in waits for the value to be set to zero.
•   If frames are used on the page that is loaded, ClickMap looks for a frame containing the SiteCatalyst image.
•   ClickMap looks at the SiteCatalyst image. The primary fields it obtains from the image include Page name, URL, Report Suite ID, 

and character set used.
•   Based on the Page Name, URL, and Report Suite ID, ClickMap requests the list of links from the SiteCatalyst databases via an HTTP 

request (this occurs through a secure API and requires authentication via the login).
•   Once the link data has been received by ClickMap, the list of links is compared to the links on the loaded page. The “Search 

Intensity“ setting is used to find the link by searching the indicated number of links above, and below, the position at which the 
object was last found. For instance, if the link was previously the 10th object on the page, and the search intensity is set to 8, then 
object 2 through 18 will be checked and will be considered a match if the URL, “action,“ and object type all match (the current 
page name or URL and Report Suite ID must also match).

•   If an “s_objectID“ attribute has been specified for a link, it can be matched exactly without a search, as long as the current page 
name (or URL) and Report Suite ID match.

•   The unmatched links are displayed in a list that can be viewed with the Search Intensity setting, which may be increased to match 
more links, but the report speed will be degraded to a minor degree (the delay depends upon the number of links on the page).
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